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SUMMARY:  19 
The intravital imaging method described here utilizes collagen second harmonic generation and 20 
endogenous fluorescence from the metabolic co-factor NAD(P)H to non-invasively segment an 21 
unlabeled tumor microenvironment into tumor, stromal, and vascular compartments for in-22 
depth analysis of 4D intravital images. 23 
 24 
ABSTRACT:  25 
The ability to visualize complex and dynamic physiological interactions between numerous cell 26 
types and the extracellular matrix (ECM) within a live tumor microenvironment is an important 27 
step toward understanding mechanisms that regulate tumor progression. While this can be 28 
accomplished through current intravital imaging techniques, it remains challenging due to the 29 
heterogeneous nature of tissues and the need for spatial context within the experimental 30 
observation. To this end, we have developed an intravital imaging workflow that pairs collagen 31 
second harmonic generation imaging, endogenous fluorescence from the metabolic co-factor 32 
NAD(P)H, and fluorescence lifetime imaging microscopy (FLIM) as a means to non-invasively 33 
compartmentalize the tumor microenvironment into basic domains of the tumor nest, the 34 
surrounding stroma or ECM, and the vasculature. This non-invasive protocol details the step-by-35 
step process ranging from the acquisition of time-lapse images of mammary tumor models to 36 
post-processing analysis and image segmentation. The primary advantage of this workflow is that 37 
it exploits metabolic signatures to contextualize the dynamically changing live tumor 38 
microenvironment without the use of exogenous fluorescent labels, making it advantageous for 39 
human patient-derived xenograft (PDX) models and future clinical use where extrinsic 40 
fluorophores are not readily applicable. 41 
 42 
INTRODUCTION:  43 
The extracellular matrix (ECM) in the tumor microenvironment is known to be dynamically 44 
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deposited and remodeled by multiple cell types to further facilitate disease progression1–3. These 45 
matrix alterations provide both mechanical and biological cues that alter cell behavior and often 46 
result in a continuing cycle of matrix remodeling4. Investigation into the dynamic, reciprocal 47 
interplay between tumor cells and the extracellular matrix is often conducted using three-48 
dimensional (3D) in vitro culture or microfluidic systems. While these bottom-up approaches 49 
have demonstrated mechanisms of ECM remodeling5–7, increased proliferation8, epithelial to 50 
mesenchymal transition9–12, and tumor cell migration and invasion7, 13–16, their focus has been 51 
primarily on a few cell types (e.g., tumor cells or fibroblasts) within a homogeneous 3D matrix 52 
compared to the diversity and heterogeneity of interactions present within a physiological tissue. 53 
In addition to in vitro systems, ex vivo tumor histology can also provide some insight into these 54 
cell-cell and cell-ECM interactions17.  Immunohistochemistry has the advantage of being able to 55 
analyze multiple cell types with respect to the spatially heterogeneous composition and 56 
architecture of the ECM, but the static endpoints of fixed tissue do not capture the dynamic 57 
nature of interactions between cells and the microenvironment.  58 
 59 
The use of intravital imaging has opened the door to interrogate live interactions within the 60 
spatial and temporal context of the native tumor microenvironment, and the capabilities of 61 
intravital tumor imaging are advancing rapidly. Improvements in the design of imaging windows 62 
and surgical techniques to implant the windows have enabled long-term longitudinal tumor 63 
imaging at a variety of anatomical locations i.e., primary tumor, lymph nodes, metastatic sites18–64 
20. Moreover, the capacity of optical instrumentation to visualize and collect data in multiple 65 
dimensions (i.e., spectral, spatial fluorescence intensity), and lifetime and at high resolution and 66 
speed (video rate) is becoming widely accessible. The improved technology provides an 67 
opportunity to explore rapid changes in cell signaling and phenotypic dynamics within a 68 
physiological environment. Lastly, the expansion of optogenetic tools and the wide array of 69 
genetic fluorescent constructs allow for the tagging of specific cell types to capture cell migration 70 
in the tumor microenvironment or cell lineage tracing during development or disease 71 
progression21, 22. The use of these tools in combination with CRISPR/Cas9 technology provides 72 
researchers the opportunity to generate unique animal models in a timely manner.  73 
 74 
While all these advances make intravital imaging an increasingly powerful method to explore 75 
dynamic and physiological cellular interactions, there is still an important need to develop 76 
strategies that provide spatial, temporal, and structural context at the tissue level to these 77 
biological interactions.  Currently, many intravital imaging studies compensate for the lack of 78 
visual landmarks such as blood vessels by injecting fluorescent dyes into the vasculature or 79 
employing mouse models that exogenously express fluorescent proteins to delineate physical 80 
features. Injectable dyes and substrates like fluorescent dextrans are broadly utilized to 81 
successfully label the vasculature in intravital collections19, 23, 24. However, this approach is not 82 
without limitations. For one, it requires additional mouse manipulations and its utility is limited 83 
to short-term experiments. For longitudinal studies, fluorescent dextran can be problematic as 84 
we observe the accumulation of dextran in phagocytic cells or diffusion into the surrounding 85 
tissue over time25. Exogenous fluorescent protein incorporation into the mouse model has been 86 
presented as an alternative to fluorescent dextrans but presents limitations of its own. The 87 
availability and diversity of exogenous fluorophores within mouse models are still limited and 88 



   

expensive to create. Additionally, in specific models, such as PDX models, genetic manipulations 89 
are not desirable or possible.  It has also been shown that the presence of fluorescent or 90 
bioluminescent proteins within cells are recognized as foreign within the mouse, and within 91 
immunocompetent mouse models, this reduces the amount of metastasis due to the response 92 
of the host immune system26, 27. Lastly, exogenous fluorescent proteins or fluorescent dyes used 93 
for spatial context or to segment subsequent data often occupy prime ranges of the light 94 
spectrum that could otherwise be used to investigate the physiological interactions of interest. 95 
 96 
The use of the intrinsic signal from the ECM or endogenous fluorescence from cells within the 97 
tissue can not only be a useful tool to characterize cell behavior or specific physiological 98 
structures but also a universal means to segment the data for more in-depth cellular and spatial 99 
analysis. Second harmonic generation (SHG) has long been used to visualize the ECM28. With the 100 
subsequent development of important tools to aid in the characterization of fiber organization29–101 
31, it is possible to characterize cell behavior relative to local ECM structure. In addition, 102 
autofluorescence from the endogenous metabolite, NAD(P)H, provides another label-free tool to 103 
compartmentalize the tumor microenvironment in vivo. NAD(P)H fluoresces brightly in tumor 104 
cells and can be used to discriminate the boundaries of the growing tumor nest from its 105 
surrounding stroma21, 32. Lastly, the vasculature is an important physiological structure in the 106 
tumor microenvironment and the site of key cell-type-specific  interactions33–35. The excitation 107 
of red blood cells (RBC) or blood plasma has been used to visualize the tumor vasculature, and 108 
using two- or three-photon excitation (2P; 3P) the measurement of blood flow rates has been 109 
shown to be possible36. However, while larger blood vessels are easily identifiable by their 110 
endogenous fluorescence signatures, the identification of subtle, variable, and less fluorescent 111 
small blood vessels requires more expertise. These inherent difficulties hinder optimal image 112 
segmentation. Fortunately, these sources of endogenous fluorescence (i.e., red blood cells and 113 
blood plasma) can also be measured by fluorescence lifetime imaging37, which capitalizes on the 114 
unique photophysical properties of the vasculature and represents a useful addition to the 115 
growing intravital toolbox.  116 
  117 
In this protocol, a workflow for the investigation of four-dimensional (4D) intravital imaging, from 118 
acquisition to analysis, explicitly using intrinsic signals like endogenous fluorescence and SHG is 119 
described. This protocol is specifically written for longitudinal studies through a mammary 120 
imaging window where exogenous fluorescence may not be practical or possible, as is the case 121 
with PDX models. The segmentation principles outlined here, however, are broadly applicable to 122 
intravital users investigating tumor biology, tissue development, or even normal tissue 123 
physiology. The reported suite of analysis approaches will allow the users to differentiate cellular 124 
behavior between regions of aligned or random collagen fiber configurations, compare numbers 125 
or behaviors of cells residing in specific regions of the tumor microenvironment, and map the 126 
vasculature to the tumor microenvironment using only label-free or intrinsic signal. Together, 127 
these methods create an operational framework for maximizing the depth of information gained 128 
from 4D intravital imaging of the mammary gland while minimizing the need for additional 129 
exogenous labels. 130 
 131 
 132 



   

PROTOCOL:  133 
 134 
All experiments described were approved by the University of Wisconsin-Madison’s Institutional 135 
Animal Care and Use Committee. The well-being and pain management in all animal experiments 136 
is paramount. Thus, every effort is made to make sure the animal is comfortable and well-cared 137 
for at each step of the procedure. 138 
 139 
1. Generation of the mammary imaging window (MIW) 140 
 141 
1.1 To construct the mammary imaging window, fabricate a 14 mm ring from surgical grade 142 
stainless steel.  143 
 144 
1.2 Clean the machined window frame using a hot solution of 5% cleaning detergent, rinse 145 
for 10 min under running deionized water (DI) water, soak in 100% ethanol for 10 min, and then 146 
dry under a heat lamp. Autoclave the dried MIW frame and store it for later use.  147 
 148 
1.3 Prepare MIW cover glass as follows. Soak the #1.5 12 mm round cover glass in 100% 149 
ethanol for 10 min, dry under a heat lamp, and then secure to the metal MIW frame using 150 
cyanoacrylate adhesive. Cure the adhesive overnight.  151 
 152 
1.4 Clean the assembled MIW of excess adhesive using an acetone soaked swab, and disinfect 153 
by submerging it in 70% ethanol for at least 1 min. Allow the cleaned window to dry. Prepare the 154 
MIW in advance and store it in a sterile Petri dish prior to surgical implantation.  155 
 156 
2. Surgical implantation of the MIW 157 
 158 
2.1 Autoclave surgical tools and sanitize surfaces with 70% ethanol before beginning the 159 
surgery for the window implantation. 160 
 161 
2.2 Perform surgery on a sanitized tabletop using a warming blanket covered with a sterile 162 
field. Set the warming blanket such that the temperature measured on top of the sterile field is 163 
40 °C.   164 

 165 
2.3 Use auxiliary cold lighting to help prevent tissue drying. Use magnifying glasses to 166 
facilitate the surgical procedure. Wear PPE consisting of a sterile, single-use lab coat, surgical 167 
sleeves, gloves, eye protection, and face mask as recommended by the surgical best practices. 168 
 169 
2.4 Anesthetize the mouse using an anesthesia  vaporizer machine with an isoflurane setting 170 
of 2.0% and flow rate of 2.0 L/min. Administer analgesic (10 mg/kg meloxicam) by subcutaneous 171 
injection.  172 
 173 
NOTE: Provide additional doses within the first 24 h, preferably every 8–12 h for the first 2 days 174 
after surgery. 175 
 176 



   

2.5  Once anesthetized (confirmed by no response to toe-pinch), apply a moisturizing eye gel 177 
to prevent drying of the eyes. Use a depilatory cream to remove fur at the surgery site (4th 178 
inguinal mammary gland) followed by rinsing with sterile water-soaked gauze.  179 
 180 
2.6 Prepare the depilated surgical site for surgery by sanitizing the skin surface with 3 181 
alternating betadine and ethanol scrubs.  182 
 183 
2.7 To begin the surgery, gently lift the skin over mammary gland number 4 using forceps. 184 
Once the skin is pulled away from the body wall, remove a ~1 mm section of the dermal layer at 185 
the tip of the forceps with surgical micro-scissors. If bleeding occurs, apply gentle pressure with 186 
sterile gauze until the bleeding stops. 187 

 188 
NOTE: In general, larger tumors have a greater potential to bleed than smaller tumors or normal 189 
tissues. 190 
 191 
2.8 Detach the mammary gland from the dermal layer with gentle forceps movements at the 192 
surgical opening to avoid cutting which will remove more of the dermal.  193 
 194 
2.9 Create a 10 mm incision and release the mammary gland from the dermal layer at the 195 
periphery so that sutures can be placed without penetrating the mammary gland. Add PBS to 196 
cover the exposed gland/tumor and to prevent drying.  197 
 198 
2.10 Create a purse-string suture along the periphery of the opening using 5-0 silk braided 199 
suture. Insert an edge of the MIW so that the dermal layer engages into the receiving notch of 200 
the MIW.  201 

 202 
2.11 Gently stretch the epithelium at the opposite side of the MIW and push the metal MIW 203 
into place such that the dermal layer fully engages the receiving notch around the entire MIW 204 
circumference. Cinch the purse string tight to draw the dermal layer into the notch and tie it off 205 
to fully secure the window.  206 
 207 
2.12 Add a topical antibiotic to the dermal layer at the MIW, and continuously monitor the 208 
mouse until it has regained sufficient consciousness to maintain sternal recumbency. House the 209 
MIW-implanted mice separately on soft bedding with an igloo placed in the cage, and allow the 210 
mouse to recover for 48 h before imaging. 211 
 212 
3. Positioning and maintaining mouse on the microscope stage for imaging  213 
 214 
3.1 Set up the heating chamber on the microscope stage.  Use a forced-air system set to 30 215 
°C or any other similar system. Use an additional objective heater to avoid drift in z focus. Allow 216 
the system to come to equilibrium for at least 1 h before imaging. 217 
 218 
NOTE: Anesthetized mice are incapable of properly maintaining their body temperature, and 219 
therefore, it is necessary to have a heated environment for any time-lapse acquisitions. The 220 



   

objective heater helps to combat the effects of thermal expansion, a phenomenon that causes 221 
drift in z focus as the objective lens and the tissue being imaged come to thermal equilibrium. 222 
 223 
3.2 Once the heating chamber on the microscope has stabilized at 30 °C, anesthetize the 224 
recipient mouse with anesthesia machine settings of 2% isoflurane and oxygen flow rate of 2 225 
L/min. Reduce the isoflurane levels to about 1% once the mouse has been anesthetized. 226 
 227 
3.3 After the mouse is sedated (confirmed by no-response to toe pinch), clean the outside of 228 
the MIW glass with a cotton applicator and glass cleaner, add eye ointment to prevent drying, 229 
and insert a tail vein catheter if necessary. 230 
 231 
3.4 To maintain proper hydration, give an initial injection of 0.5 mL PBS sub-cutaneously or 232 
100 µL through the tail vein catheter. Repeat every 2 h for the duration of the imaging session. 233 
  234 
3.5 Once the mouse has been properly prepared, gently transfer it to the pre-warmed 235 
microscope stage.  236 
 237 
3.6  Lay the mouse on the microscope stage, fit the isoflurane hose and press the collar of the 238 
MIW into a 14 mm receiving hole in the stage insert to stabilize the images. Bring the imaging 239 
field into focus using the microscope oculars and bright field illumination observing vasculature 240 
with blood flow.  241 

 242 
3.7 Check the stability of the field of view. If breathing movement artifacts are present, apply 243 
gentle compression to the backside of the gland with a small foam block and a cincture-like piece 244 
of adhesive tape. After compression is applied, verify that blood flow is maintained throughout 245 
the field of view. 246 
 247 
3.8 Periodically adjust the isoflurane levels in 0.25% increments during the imaging session 248 
to maintain a proper level of sedation by manually counting animal respiration.  249 

 250 
3.9 Maintain a rate of 36–40 respirations per min (rpm) to improve animal longevity and 251 
optical imaging. Lower respiration rates can result in the mouse not surviving the experiment, 252 
whereas respiration rates over 60 rpm may result in poor sedation, which can increase breathing 253 
and motion artifacts in the image data. 254 
 255 
4. Set up for 4D, intensity-based, label-free intravital imaging of dynamic cell behavior 256 
 257 
4.1 Once the mouse is sedated and securely positioned on the inverted microscope stage, 258 
start locating regions of interest. For time-lapse measurements, use a water-based gel instead of 259 
water for the objective to reduce evaporation that can lengthen the imaging session. Please see 260 
the Table of Materials for details of the optical components. 261 
 262 
4.2 Using a light source directed at the MIW, use the oculars of the microscope to identify 263 
potential areas for investigation. Add and save the x, y positions in the software to return to these 264 



   

positions.  265 
 266 

NOTE: The fine details of the tumor will not be readily visible with this type of illumination. The 267 
goal is simply to identify regions for further investigation. The focus is on seeing vasculature and 268 
blood flow. 269 
 270 
4.3 After several positions have been saved in the software, preview the chosen fields of view 271 
using 890 nm excitation and the FAD/SHG filter cube. Use a maximum dwell time of 4 µs with 272 
lower power and high PMT setting. The goal is to preview the fields of view without overexposing 273 
the tissue to excessive laser light. 274 
 275 
4.4 Once appropriate power levels have been set, set up the z-stacks. Observe appearance of 276 
abundant collagen fibers (SHG) at 20–50 µm beneath the glass surface of the MIW. Collagen will 277 
become less prevalent as the microscope sections deeper into the tumor  (Figure 1B). Voids in 278 
the SHG reveal the location of tumor masses.  279 

 280 
4.5 Set the top z-slice, beneath the layer of solitary cells where the first collagen fibers appear 281 
at ~50–100 µm. Set the bottom z-slice at ~250 µm, where the fibers fade out and the poor signal 282 
dominates. Repeat this for all x-y positions saved. 283 
  284 
4.6 Once the z-stack range is set, increase the dwell time (up to 8 µs) and optimize the power 285 
and detector settings. Optimize the power levels needed to excite the tissue for each experiment. 286 
Using powers up to 90 mW at 750 nm or 70 mW at 890 nm at the back aperture of the objective 287 
are within an acceptable range.  288 

 289 
NOTE: The imaging depth, amount of scattering within the tissue, objective characteristics, and 290 
detector sensitivity will all significantly impact the amount of power needed to get an image.  291 
 292 
4.7 Adjust the time intervals according to experimental goals. Start with 10 min intervals 293 
between collection points for most intravital migration movies.  294 
 295 
4.8 Even though 2P excitation is gentle on cells and tissues, be cognizant of signs of 296 
phototoxicity, like cell blebbing or rapidly increasing autofluorescence, and excessive 297 
photobleaching. Reduce laser power or increase timelapse intervals as conditions indicate.  298 
 299 
5. Fluorescence lifetime imaging (FLIM) of NAD(P)H  300 
 301 
5.1 While preserving the x-y positions from the timelapse acquisitions, set up the microscope 302 
to collect a FLIM stack. Insert a 440/80 filter into a filter holder in front of the GaAsP detector, 303 
and set the GaAsP detector voltage to 800 in the software.  Turn off the room lights when the 304 
detectors are on.  305 
 306 
5.2 In the software, switch from the galvanometer-based intensity imaging to a FLIM imaging 307 
mode.  308 



   

 309 
5.3 For the purpose of identifying and masking the vasculature, set the resolution to 512 x 310 
512 pixels. For collecting complementary metabolic information, set the resolution to 256 x 256 311 
pixels to increase the temporal resolution of the lifetime signature. Set the dwell time to 4 µs and 312 
tune the laser to 750 nm.  313 

 314 
5.4 Start preview scanning and begin to adjust the laser power. Adjust the laser power until 315 
the readout for the constant fraction discriminator (CFD) is between 1 x 105 and 1 x 106. Do not 316 
exceed 1 x 106 as this will result in photon pileup and poor overall results. 317 
  318 
5.5 Once the power level is set, set the integration time between 90 s and 120 s and start the 319 
FLIM collection. It will acquire photons from the field of view for the allotted time.  320 
 321 
5.6 Optional: After all necessary collections have been made and the mouse has been 322 
removed from the stage, collect an instrument response function (IRF). Measure the IRF by 323 
imaging the surface of commercially available urea crystals in a glass-bottom dish with the same 324 
parameters and set up used for imaging the tissue. 325 
 326 
NOTE: The IRF accounts for any delays or reflections due to the electronic or optical setup. The 327 
IRF is convolved in all FLIM acquisitions, and deconvolving it from the data can improve the 328 
accuracy of calculated fluorescence decay curves. With that said, the calculated IRFs can often 329 
reasonably replicate the quality of the fluorescence decay curves from measured IRF. It is good 330 
practice to measure the IRF until it has been determined that the calculated IRF will yield 331 
equivalent fits of the decay curves and adequately approximate the results from the measured 332 
IRF.  333 
 334 
6. Analysis of NADH Lifetime images 335 
 336 
6.1 Open FLIM software and import the NAD(P)H lifetime image from the dataset. For more 337 
details on how to properly use the software, please consult the fluorescent lifetime handbooks 338 
(See Table of Materials).  339 
 340 
6.2 To begin, define the model parameters in the software. In the menu bar, click   Options > 341 
Model. Select the following boxes: Settings > Multi-Exponential Decay, Fit Method > MLE, 342 
Spatial Binning > Square, Threshold > Peak, and check Fix Shift Before Calculating Image. 343 
 344 
6.3 In the menu bar, click Color >  A1% from the drop-down menu. On the right side of the 345 
window, define it as a three-component fit. Set the Bin Size > 3. 346 
 347 
6.4 Adjust the Threshold > ~10. Re-evaluate threshold accuracy after the decay matrix has 348 
been calculated for the first time. 349 
 350 
6.5 Fix the τ1 to 200 ps. This represents the short lifetime of red blood cells. Try to find the 351 
value that best matches multiple spots in the larger blood vessel, which can be seen in the 352 



   

intensity image. Fix the τ2 to 1200 ps. This represents the long lifetime of red blood cells.  353 
 354 
NOTE: The set values are just the starting point. The values will need to be optimized to bring out 355 
the vasculature more. In most cases, but not always, these values will decrease.  356 
 357 
6.6 Under Calculate in the menu bar, select Decay Matrix. This will generate an initial A1% 358 
lifetime images with the vasculature having high values. Use the cursor (crosshairs) to hover over 359 
the vasculature. Systematically and one at a time, float (uncheck the Fix box) the τ1 and τ2. 360 
Record these values as they will help optimize the fixed parameters.  361 
 362 
NOTE: The goal is not necessarily to get the most accurate values in the image, but rather to 363 
maximize the disparity between the vasculature and tissue without dramatically decreasing the 364 
area identified as vasculature. 365 
 366 
6.7 Once the appropriate parameters for τ1 and τ2 have been identified, in the menu bar 367 
select Calculate > Batch Processing. Ensure that most settings are similar between z-slices.  368 
 369 
6.8 Make sure to verify that there is no one setting grossly different than the others. If so, 370 
adjust the shift first and try again. If the issue persists, refit using new parameters. An incorrect 371 
shift can be a large cause of noise in the fits and can increase A1% values in the adjacent tumor 372 
regions. 373 
 374 
6.9 In the menu tab, save the files and then export A1% files. Upload these files in ImageJ for 375 
masking and segmentation. 376 
 377 
7. Image segmentation of the vasculature  378 
 379 
7.1 Open ImageJ and import the A1% image as a text image. Repeat this for all images within 380 
the stack. 381 
 382 
7.2 With all the A1% images opened, select Image > Stack > Z-Project. Use the  Max Intensity 383 
Projection and save the images. See Supplemental Data 1 for a representative image. 384 
 385 
7.3 Go to Plugins > Segmentation. Select the trainable WEKA segmentation plugin38. 386 
 387 
7.4 Once the WEKA window opens, use the default settings and begin to train the software 388 
by creating two classes and tracing lines over the vasculature (high A1% regions) and non-389 
vasculature (low A1% regions).  390 

 391 
7.5 Continue to add new traces to the two classes until the software consistently identifies 392 
the high A1% regions of the vasculature while eliminating any higher regions of background noise.  393 
See Supplemental Model for representative classifier model. 394 
 395 
7.6 Once the classified image is produced, click on Image > Type > 8 Bit. Threshold the image 396 



   

and create a mask. If the thresholded image still needs to be cleaned up further, use the Analyze 397 
Particles function.  398 

 399 
7.7  Adjust the size and circularity until any smaller and circular regions of the thresholded 400 
image are excluded. A clean mask with only the vasculature and very little background is 401 
obtained. 402 
 403 
7.8 Click on Edit > Selection > Create Selection. Transfer the selection to the ROI manager by 404 
clicking on Analyze > Tools > ROI manager.  405 
 406 
7.9 Duplicate the classified image. Proceed to Process > Binary. To expand the mask and 407 
define the distance from the vasculature that will be included in the image segmentation, select 408 
Dilate. Repeat until the mask has expanded to the desired range. Record this region of interest 409 
(ROI) in the ROI manager.  410 

 411 
NOTE: The goal of this step is to quantify the amount or behavior within a certain proximity of 412 
the blood vessel (for example, the number of cells present within X µm of the blood vessels). The 413 
amount of dilation required is entirely determined by the scientific question.  414 
 415 
7.10 To quantify the number of cells within the restrictive regions, select the window 416 
(image/channel) of interest. This can be any window that shares the same field of view as the 417 
vascular mask. Apply both ROI’s using the XOR function from the drop-down menu.  418 
 419 
NOTE: This operation will measure the items within the desired distance from the vasculature, 420 
excluding the vasculature itself. This combined ROI approach can then be used to measure a 421 
multitude of parameters, such as intensity, cell number, or migration. 422 
 423 
8. Image segmentation of the tumor nest  424 
 425 
8.1 Open the NADH image from either a high-resolution intensity scan or FLIM collection in 426 
ImageJ.  427 
 428 
NOTE: This can be done on individual z-slices, full stacks, or applied to z-projections of a few 429 
slices. 430 
 431 
8.2 Go to Plugins > Segmentation. Select the trainable WEKA segmentation plugin. 432 
 433 
8.3 Once the WEKA window opens, use the default settings and begin to train the software 434 
into two classes of NADH high regions and NADH low regions. The NADH-high regions will have a 435 
very discernable pattern of cells with nuclei and the software will easily identify it.  436 
 437 
8.4 Continue to toggle back and forth with the overlay to refine the algorithm with additional 438 
training until it recognizes all regions of the tumor as determined by eye and prior knowledge of 439 
tumor morphology. This is an iterative process. 440 



   

 441 
8.5 Once the algorithm recognizes all the regions of the tumor, select the Create Result 442 
button. This will produce a new image. Duplicate this image.   443 
 444 
8.6 Select the first duplicated image and convert it to an 8 bit image by selecting Image > 445 
Type > 8 Bit. Threshold this image to create a binary mask. Then create a selection and transfer 446 
it to the ROI manager. These ROIs will define the stroma. 447 
 448 
8.7 Select the second of the duplicated image and convert it to an 8 bit image. Invert this 449 
image by selecting Image > Edit > Invert, and then threshold this image to create a binary mask. 450 
Once again create a selection and transfer it to the ROI manager. This ROI will define the tumor 451 
nest. 452 
 453 
9. Image segmentation by fiber organization or alignment 454 
 455 
9.1 To begin, open the SHG images, prepare any z-projection, and assess the need for any 456 
pre-processing. For good results, high-quality images with discernable fibers and low noise are 457 
required. 458 
 459 
9.2 Optional: For preprocessing in ImageJ to increase signal-to-noise (SNR) of the SHG 460 
channel, subtract the background using a rolling ball subtraction. For most applications, use a 461 
rolling ball subtraction between 20 pixels and 50 pixels. Then smoothen the image and save it.  462 
  463 
9.3 Open the OrientationJ plugin and set the processing parameters. In the OrientationJ 464 
window, define the size of the local tensor window. For a 20x image of this fiber density, set 10 465 
pixels to 15 pixels as a starting point. 466 
  467 
9.4  Select Cubic Spline as the gradient model and check the Color Survey Box. Define the 468 
color survey. Set both the Hue and Saturation as Coherency, and then define the Brightness as 469 
Original Image, hit Run. 470 
 471 
9.5 The output file of the plugin is RGB colormap.  Adjust the value of the local tensor window 472 
until aligned regions, as determined by the eye, are properly highlighted with blue and magenta 473 
hues. 474 
 475 
9.6 Once the output image is satisfactory, separate this RGB image into 3 channels. Select 476 
Image > Color > Split Channel. 477 
 478 
9.7 To enhance the appearance of aligned regions for the purpose of masking, use the image 479 
calculator by selecting Process > Image Calculator. Using this operator, subtract the green image 480 
from the blue image. For a more restrictive mask, subtract the green image from the red image. 481 
For random regions, subtract the blue channel from the green channel. 482 
 483 
9.8 Threshold the resulting image using the Moments algorithm. In most cases, this should 484 



   

not need further adjustments. However, adjust if needed. This will produce a binary image. 485 
 486 
9.9 Once the binary image is made, fill the holes by selecting Process > Binary > Fill Holes 487 
between fibers and round out the boundaries of the mask using a median filter. A median filter 488 
of 10 is a good starting point, adjust it to make a good fit for the data. Manually inspect the mask 489 
for agreement and remove any ROIs that are erroneous. 490 
 491 
9.10 Once the mask is satisfactory, create a selection by selecting Edit > Selection > Create 492 
Selection. Transfer this selection to the ROI manager. 493 
    494 
REPRESENTATIVE RESULTS:  495 
The installation of the MIW and basic experimental planning are the first steps in this process. 496 
This particular MIW design and protocol are more amenable to longitudinal studies19 and has 497 
been successfully utilized with both upright and inverted microscopes. In this case, an inverted 498 
microscope was used as it has resulted in greater image stability of the mammary gland with 499 
fewer breathing artifacts. In Figure 1A, we provide the dimensions of the rigid MIW and a 500 
graphical overview of the implantation process.  501 
 502 
A typical field of view within a label-free MMTV-PyMT39 mammary tumor (Figure 1B–E, Figure 503 
3A) is very heterogeneous, comprising of collagen fibers, numerous stromal cells, masses of 504 
tumor cells, and vasculature (Figure 3A). In general, collagen fibers are more abundant near the 505 
window and decrease in abundance deeper into the tumor (Figure 1B–E) The organization of the 506 
fibers surrounding the tumor masses can also be quite varied, often with regions of more random 507 
organization in the same field of view as regions of higher alignment (Figure 2D,H and Figure 3I).  508 
 509 
To develop an analysis pipeline that can segment intravital data into perivascular regions, tumor 510 
and stroma, this protocol focused on using the signal from endogenous NAD(P)H and SHG. While 511 
identification of the tumor and stroma can be straightforward, the identification of perivascular 512 
regions within the tumor microenvironment can be challenging. The vasculature often resides 513 
within the narrow ribbons of reduced NAD(P)H signal between the bright NAD(P)H+ cancer cell 514 
masses. It is important to note that not all dark boundaries harbor vasculature; rather, some dark 515 
regions are simply tumor folds or the butting up of adjacent tumor lobes (yellow arrow, Figure 516 
2G). Moreover, while a seasoned eye can extract the bigger diameter blood vessels from the 517 
tumor as they have a distinctive appearance, this distinction is not always trivial. This is especially 518 
true for smaller diameter vessels where their appearance may be more subtle and variable. In 519 
this case, the use of the fluorescence lifetime of NAD(P)H can aid in the positive identification of 520 
the vasculature (Figure 2B,F). Fluorescence lifetime (FLIM) does not measure the abundance or 521 
intensity of photons at a location, but the time it takes for those excited molecules to decay to 522 
their ground state. Red blood cells (RBC) and blood plasma have been shown to have a 523 
characteristically short and distinctive fluorescence lifetime32, 37 that can be leveraged for the 524 
identification and segmentation of vessels in tissues.  525 
  526 
To determine how well the fluorescence lifetime of NAD(P)H identifies the vasculature 527 
intravitally, a 100 µL bolus of a rhodamine-labelled dextran was injected into the tail vein after 528 



   

collecting the FLIM image. Comparisons of maximum intensity projections of NAD(P)H FLIM 529 
closely mirror those vessels labeled with a fluorescently labeled dextran (Figure 2I–J).  Repeating 530 
this approach in multiple mice demonstrated that the average mask area from the FLIM image 531 
over the area of the dextran mask was 78.6% ± 12.3% (Figure 2L).  While the overlay was not 532 
100%, this technique was accurately mapping the entire vascular network. The differences 533 
observed in the reported areas could often be attributed to intravital drift or registration issues, 534 
thinner vessel diameters due to model fitting, or the loss of fine vessels due to RBC exclusion by 535 
the pressure of the growing mass. Importantly, this technique works equally well in the presence 536 
of both genetically encoded fluorophores like GFP or label-free tumor models (Figure 2D,H), 537 
thereby providing a very robust and broadly applicable means of identifying the vasculature for 538 
image segmentation. 539 
  540 
To delineate the boundaries of label-free tumor masses, NAD(P)H autofluorescence (Figure 1C) 541 
was used. This can be captured by either independently collecting a NAD(P)H image or 542 
summating the NAD(P)H FLIM data to generate an intensity image. Either route will allow for 543 
suitable segmentation of the tumor microenvironment. As a general observation, two-photon 544 
excitation of NAD(P)H in cancer cells elicits bright autofluorescence producing an image that 545 
shows crisp individual cells with darkened nuclei (Figure 2E,G). This pattern can be used to define 546 
the extent of the growing mass. While simple intensity-based thresholding of NAD(P)H is possible 547 
to define the boundary of the tumor compartment, a trainable segmentation tool often performs 548 
better (Figure 3B,E). Some other common readouts, like cell migration or cellular protrusive 549 
analysis, may benefit from genetically encoded exogenous fluorescence within the mouse model 550 
or the implantation of fluorescently labeled cell lines (Figure 2A). In these cases, the task of 551 
demarcating the boundary of the mass can be accomplished with simple thresholding of the 552 
fluorescent protein. Sometimes the expression of the fluorophore can become quite 553 
heterogenous after implantation. This should not cause segmentation problems. Also, it has 554 
often been observed that tumors created by fluorescent allografts or xenografts have less 555 
compartmentalized regions of collagen fibers than tumors created by genetic tumor models like 556 
MMTV-PyMT40.  557 
 558 
The stromal compartment encompasses the regions outside the growing mass or between 559 
growing masses, and a mask for the stroma is obtained by inverting the tumor ROI (Figure 3B-F). 560 
The stromal compartment can then be further compartmentalized into sub-ROIs based on 561 
collagen fiber architecture. Collagen fibers are a significant feature in the stroma and have a large 562 
diversity of fiber organizations, which are known to modulate cell behavior41, 42. Often numerous 563 
local (<100 µm) regions of aligned or random fibers exist within the image40. Therefore, regions 564 
of relatively aligned (red/blue hues) or random (green hues) fiber organization (Figure 3I) were 565 
identified with the OrientationJ plugin. Using the OrientationJ coherency color map, masks based 566 
on the local fiber organization can be created for segmentation purposes (Figure 3J). These masks 567 
can then be overlaid to analyze differential dynamic stromal cell behavior (Figure 3K) due to the 568 
effects of specific fiber organization (Figure 3H,I). 569 
 570 
Now that ROIs for the various compartments of the tumor microenvironment have been defined, 571 
they can be applied to the individual frames or channels of the intravital timelapse movie.  At this 572 



   

point, it is important to emphasize that all the signals shown in Figure 3A are derived entirely 573 
from endogenous sources. This image demonstrates the rich potential of spatial and contextual 574 
cues that can come from purely endogenous, ubiquitous, and label-free sources. Here, we used 575 
the MMTV-PyMT tumor model as an example to illustrate the applicabilty of the method to 576 
quantify the number and characteristics of macrophages within specific locations of the tumor 577 
microenvironment (TME). A previous intravital study43 has shown that cells emitting high levels 578 
of FAD autofluorescence (Figure 3A, magenta cells, yellow arrows) stain positively with F4/80 579 
antibodies and represent a population of macrophages within the TME.  Using this workflow to 580 
segment the image, it is possible to efficiently and accurately examine the number, monitor cell-581 
cell interactions over time, or even observe the metabolic characteristics of this subset of 582 
macrophages (magenta) within different compartments of the TME (Figure 3A, yellow arrows). 583 
For example, the behavior of FAD-high macrophages that specifically reside within the NAD(P)H-584 
high tumor nest can be characterized (Figure 3E). Similarly, the behaviors of macrophages with 585 
respect to the local organization of the fibers in the stroma region can be examined. Some recent 586 
reports have indicated that macrophages and other migrating cells in the stroma are responsive 587 
to mechanical cues from their local microenvironment40, 44, 45. Using the fiber alignment masks 588 
produced by this method, it is possible to examine their differential behaviors between regions 589 
of random and aligned collagen organizations. Lastly, this same focused analysis can also be 590 
applied to determine the number and the behavior of macrophages localized within a defined 591 
proximity to the vasculature. In Figure 3G, the vasculature can be seen in red, and macrophages 592 
can once again be seen in magenta. A mask for the vasculature using NAD(P)H FLIM was created 593 
and then expanded through dilation of 10 pixels. The distance chosen was arbitrary for 594 
demonstration purposes but can be optimized for the particular needs of the individual 595 
experiment. Importantly, while this image is of a single z-slice, this procedure could be easily 596 
extrapolated to 3D stacks to observe behavior around the entire volume of the vessel. 597 

 598 
FIGURE AND TABLE LEGENDS:  599 
Figure 1: Graphical abstract of mammary window implantation and the underlying 600 
organization of an MMTV-PyMT tumor. (A) The dimensions of the mammary imaging window 601 
and schematic for the general implantation process. (B–F) This is a montage from an unlabeled 602 
MMTV-PyMT tumor representative starting from 50 µm beneath the surface of the MIW and 603 
continuing to a depth of 80 µm. The depth values are provided beneath each image. Collagen 604 
fibers (gray) are more prevalent at the surface of the tumor (NAD(P)H, blue) than at greater 605 
depths. Scale bar 100 µm. 606 
 607 
Figure 2: Representative intravital image of a GFP labeled and label-free PyMT tumor and 608 
validation of NAD(P)H FLIM as a marker for the vasculature. A composite image (A) of a typical 609 
allograft of GFP-4T1 cells into the mammary fat pad and a representative mammary tumor from 610 
an MMTV-PyMT tumor model (E). NAD(P)H FLIM (D) maps the vasculature in both models (B,F). 611 
GFP fluorescence (C) and NAD(P)H autofluorescence (G) were used to identify the tumor. 612 
Collagen was visualized by SHG (D,H). A composite image using NAD(P)H FLIM to identify 613 
vasculature was validated by comparing maximum intensity projections of the intravital stack 614 
before and after tail vein injection of fluorescent dextran (I,J,K). The quantification of four mice 615 



   

(color identifies individual mice) and fields of view (individual dots in graph) is shown in (L). Scale 616 
bars 100 µm. 617 
 618 
Figure 3: Representative image segmentation using endogenous fluorescence within label-free 619 
PyMT tumor. A composite image (A) of a single z-slice from a typical mammary tumor was 620 
collected using intrinsic signals only. SHG (gray) visualizes the collagen fibers of the tumor. 621 
Fluorescence lifetime imaging of NAD(P)H autofluorescence (Tau (τ) mean) reports the metabolic 622 
signatures of the cells (green to orange hues) and the location of blood vessels (red). FAD 623 
autofluorescence (magenta) identifies macrophages. Using the segmentation scheme outlined in 624 
this protocol, the label-free tumor was segmented into compartments for the tumor nest (B,E), 625 
stroma (C,F), and vasculature (D,G) using only SHG and NAD(P)H autofluorescence. The stroma 626 
and collagen fibers (H) can also be classified into local regions of aligned fibers ((shown in 627 
magenta/blue), J,K). Scale bars 100 µm. 628 
 629 
Supplemental Data 1: Representative data set of fitted A1% from NAD(P)H FLIM. This is a 630 
maximum intensity projection of a fitted A1% from a typical data set. It is a representative of the 631 
quality of identification possible and a typical level of background before using the trainable 632 
classifier. 633 
 634 
Supplemental Model: Representative classifier used on fitted A1% for the identification of the 635 
vasculature.  This is a sample classifier model for use in the trainable WEKA segmentation plugin 636 
within ImageJ.  637 
 638 
DISCUSSION:  639 
The 4D intravital imaging is a powerful tool to investigate dynamic physiological interactions 640 
within the spatial and temporal context of the native tumor microenvironment. This manuscript 641 
provides a very basic and adaptable operational framework to compartmentalize dynamic cell 642 
interactions within the tumor mass, the adjacent stroma, or within proximity to the vascular 643 
network using only endogenous signals from second harmonic generation or NAD(P)H 644 
autofluorescence. This protocol provides a comprehensive, step-by-step method from 645 
implantation of the imaging window to image acquisition, analysis, and segmentation. We 646 
believe this technique will contribute to a needed analysis framework to segment and quantify 647 
4D intravital data. 648 
 649 
This protocol was developed to be broadly compatible with numerous intravital mouse models, 650 
including unlabeled PDX models. PDX’s are an incredibly informative model46 but pose a 651 
challenge to intravital imaging because the nature of the PDX model is not well-suited for genetic 652 
manipulation. Therefore, it would be quite advantageous to be able to visualize dynamic 653 
interactions in PDX models within a physiological environment while still being able to segment 654 
the images using solely endogenous metabolites like NAD(P)H and second harmonic generation 655 
(SHG). In addition to being advantageous for PDX models, this multidimensional approach could 656 
be theoretically applied to any tumor or normal tissue study that needs spatial and structural 657 
context to address a physiological question. NAD(P)H autofluorescence and SHG from collagen 658 
fibers are ubiquitous to all tissues and represent a universal and free resource in intravital 659 



   

collections.  It is also notable that this FLIM approach to identifying the vasculature is robust even 660 
in the presence of fluorescence from exogenous sources like GFP. Lastly, SHG and NAD(P)H 661 
emission can be visualized in the blue spectrum, thereby residing in a wavelength that is not 662 
typically used in the imaging of fluorescent fusion constructs.  663 
 664 
The aspect of this approach that is novel and has particular added value is the label-free 665 
identification of the vasculature. While other approaches can work, the use of the fluorescence 666 
lifetime of NAD(P)H easily provides a clear signature without additional labeling. The data shows 667 
that the lifetime-defined vessels mirror the vasculature labeled from tail vein injection of 668 
fluorescent dextran, the gold standard for vasculature imaging. Our technique excels at 669 
visualizing smaller blood vessels compared to simple two-photon or three-photon excitation, 670 
where larger vessels are easily visualized, but smaller ones require more expertise to identify. 671 
The lifetime signature is unambiguous for all vessels, regardless of size. Moreover, this additional 672 
NAD(P)H FLIM acquisition can be easily combined with other markers for the segmentation of 673 
the tumor microenvironment. Through a single FLIM acquisition of NAD(P)H, the requirements 674 
for defining the vasculature, tumor nest, and stroma are achievable. The FLIM collection can be 675 
incorporated into the existing experimental design by collecting a single acquisition at the end or 676 
beginning of a time series or interleaving the collections throughout the entire 4D acquisition. 677 
Determination of the appropriate amount of FLIM images will depend on specific experimental 678 
needs and constraints, like acquisition intervals, experimental duration, or image stability, but at 679 
a minimum, one FLIM collection per 4D series will be needed for this method. 680 
 681 
 This process of utilizing NAD(P)H FLIM for the identification of the vasculature requires 682 
mathematically fitting the FLIM data to an exponential function of the form 683 

𝑓(𝑡) = 𝐴1𝑒
−𝑡/(𝜏1) + 𝐴2𝑒

−𝑡/(𝜏2) + 𝐴3𝑒
−𝑡/(𝜏3) 684 

with A1+A2+A3=1.  While most lifetime images of NAD(P)H reported in the literature are fitted as 685 
a bi-exponential, in this application NAD(P)H was fitted as a tri-exponential where the τ1 and τ2 686 
are set to the reported values of RBC’s and τ3 is allowed to float. Importantly, the goal is not to 687 
achieve the most accurate lifetime value, but rather to provide an optimal image for 688 
segmentation. When the τ1 and τ2 values are initially fixed at the reported values of RBC’s32, 47 689 
and the matrix is calculated, the blood vessels will stand out with A1% values greater than 60% in 690 
the blood vessels and A1% values generally less than 40% in the adjacent tumor. The next step is 691 
to try to maximize the A1% in the blood vessels while minimizing the A1% in the adjacent tumor. 692 
This is an iterative process, and by the end of it, the A1% values of the blood vessels will be greater 693 
than 90% with the A1% values of the tumor less than 10%. Once the A1% values of the blood 694 
vessels are uniformly high and the background is uniformly low, export these A1% files into a 695 
trainable segmentation tool. This will quickly remove any remaining noise and define the ROI for 696 
the vasculature.  697 
 698 
As the mammary fat pad is located outside of the body cavity, the surgery is minimally invasive, 699 
and the best results are obtained by implanting the MIW over the 4th inguinal mammary gland. 700 
The timing of window implantation and when the experiment will be conducted is critical. It is 701 
best to allow for 24 – 48 h of healing post-surgery before the physiological timepoint that will be 702 
investigated. While the procedure itself only requires a small incision (≈ 10 mm) to insert the 703 



   

window (Figure 1A), post-surgery healing time will permit any inflammation and fluids that 704 
accumulated due to the implantation process to clear. Moreover, it will also allow the tumor to 705 
continue to grow into the window. Both factors will improve the overall image quality by 706 
decreasing opacity/scattering and increasing image stability. The next thing to consider is the 707 
planned total duration of the experiment. While these windows were designed for longitudinal 708 
studies, the rigid nature of the window incurs a time limit of 2 to 3 weeks. After that timespan, 709 
the window has a tendency to dislodge from the dermal layer, thereby contaminating and 710 
terminating the experiment. If a longitudinal study of the mammary gland is not required, other 711 
intravital methods like a terminal skin flap procedure22 that eliminates the surgical implantation 712 
of a MIW may be a better option. The skin flap procedure provides better access to the entire 713 
gland as it is not constrained by the placement and dimensions of the MIW, and it can produce 714 
greater image stability as the gland is pulled away from the body cavity. Regardless of the 715 
intravital imaging approach, the segmentation of the microenvironment using endogenous 716 
fluorescence is still broadly applicable for subsequent image analysis. The last thing to consider 717 
is the duration of the individual imaging experiment. It is not unreasonable to acquire movies 718 
lasting 6–8 h. However, during the longer collections, hydration becomes an issue, and close 719 
monitoring of the health of the mouse is required.  720 
 721 
One significant advantage of this method is that the various images of endogenous fluorescence 722 
required for segmentation of the tumor microenvironment can be collected with relative ease 723 
and without additional manipulations to the mouse. With the filter/dichroic combination 724 
reported here (Table of Materials), both SHG and NADH images can be acquired with the same 725 
filter set by switching wavelengths from 890 nm to 750 nm. While this creates an acquisition 726 
delay, it does not impact subsequent image segmentation. It is also important to remember that 727 
this method represents a mere starting point for a segmentation technique using endogenous 728 
fluorescence, and more advanced optical configurations may allow for simultaneous acquisitions 729 
if needed. 730 
 731 
There are limitations of using FLIM to identify the vasculature. The FLIM approach requires 732 
specialized electronics, instrumentation, and expertise to collect. However, all these 733 
requirements are increasingly more integrated into modern microscopes and more available 734 
through the use of imaging core facilities. FLIM has become a mature technology and acquiring 735 
good data does not require much training. A second limitation is that FLIM acquisitions are time-736 
consuming. While the frame rate for an image collected with fluorescent dextran is about a 737 
second or less, the average FLIM collection can range from 60 s to 120 s, which may be prohibitive 738 
if the physiological timepoints are shorter than that. FLIM identification of the vasculature is not 739 
intended to replace all tail vein injected fluorescent dextran or multiphoton excitation of the 740 
vasculature; rather, it is yet another approach in the growing toolbox for intravital imaging. 741 
Furthermore, we anticipate that longer acquisition times will be made dramatically shorter in the 742 
coming years. The detectors and electronics are rapidly improving, decreasing the detector dead 743 
time, and thereby requiring shorter acquisition periods to capture the same number of photons. 744 
The second reason to be optimistic of shorter acquisition times is the emergence of machine 745 
learning software or image restoration algorithm like CSBDeep48.  These algorithms could be 746 
potentially trained to work with shorter exposure times and reduce the number of photons 747 



   

needed to accurately identify structures for segmentation purposes. Together, this could rapidly 748 
reduce the timeframes needed for these multidimensional acquisitions.  749 
 750 
The use of intravital imaging will only become more important as researchers try to unravel the 751 
many complex cell-cell and cell-matrix interactions that occur within the physiological tumor 752 
microenvironment. Therefore, continued developments in the acquisition, segmentation and 753 
analysis capabilities are needed. Towards this end, it is important to not overlook the potential 754 
of endogenous fluorescence images for microenvironment segmentation. In this protocol, the 755 
endogenous signal from SHG and fluorescence metabolites, including NAD(P)H intensity and 756 
FLIM, was used for segmentation purposes during intravital imaging of the mammary TME. Other 757 
endogenous metabolites or intrinsic properties can provide additional signals to reveal the 758 
dynamic reciprocity of tumor cells and the microenvironment. For example, FAD can be used to 759 
monitor the movement of immune populations43, 3P generation can highlight structural features 760 
like plasma membranes or adipose36, and elastin fluorescence can be used to separate arteries 761 
from veins47. Therefore, endogenous fluorescence will continue to provide a rich multi-762 
dimensional platform that should be utilized to the fullest as the research community continues 763 
to build the toolbox for intravital microenvironment segmentation and analysis.   764 
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Please note that the reviewers raised some significant concerns regarding your 

method and your manuscript. Please revise the manuscript to thoroughly address 

these concerns. Additionally, please describe the changes that have been made or 

provide explanations if the comment is not addressed in a rebuttal letter. We may 

send the revised manuscript and the rebuttal letter back to peer review. 

 

 

Editorial comments: 

Editorial changes to be made by Authors: 

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there 

are no spelling or grammar issues.  

 

2. Please revise the text to avoid the use of any personal pronouns (e.g., "we", "you", "our" 

etc.). We have removed versions of “we”, “you”, or “our” from the manuscript 

 

3. Please ensure that the Introduction also includes all of the following: 

a) A description of the context of the technique in the wider body of literature 

We have added additional lines of text to further describe the technique and why this 

technique is needed. (lines 86-104 and lines 126-130) 

b) Information to help readers to determine whether the method is appropriate for their 

application 

We have added additional lines of text to specify that this method was specifically written 

for longitudinal intravital imaging of the mammary tumor microenvironment (lines 126-130). 

However, we also indicate that this would be of value for anyone trying to segment images 

from intravital movies. I think this technique is broadly applicable. 

 

4. JoVE cannot publish manuscripts containing commercial language. This includes 

trademark symbols (™), registered symbols (®), and company names before an instrument 

or reagent. Please remove all commercial language from your manuscript and use generic 

terms instead. All commercial products should be sufficiently referenced in the Table of 

Materials (For example: Swift Manufacturing, Warner Instruments, Loctite 1365882, Tokai 

Hit, Bruker, Coherent Chameleon, PrairieView, Becker and Hickl SPC-150, Hamamatsu 

H7422P-40, SpcImage, etc.) 

All commercial language has been removed and placed into the required Table of Materials 

excel sheet.  

 

5. Replace ml with mL and µl with µL. Use min for minutes, h for hours throughout the 

manuscript. 
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All inappropriate abbreviations have been changed throughout the document. 

 

6. Line 321: please move the website to Table of Materials and refer to it wherever needed. 

The website has been moved to the table of materials 

 

7. Please ensure that all text in the protocol section is written in the imperative tense as if 

telling someone how to do the technique (e.g., “Do this,” “Ensure that,” etc.). The actions 

should be described in the imperative tense in complete sentences wherever possible. Avoid 

usage of phrases such as “could be,” “should be,” and “would be” throughout the Protocol. 

Any text that cannot be written in the imperative tense (instructions, remarks, 

extraneous/cautionary details) may be added as a “Note.” However, notes should be concise 

and used sparingly. Please include all safety procedures and use of hoods, etc. 

The paper has been proofread and changed to the imperative tense whenever possible. 

Statements that are not suitable for the imperative tense were changed to “Notes”. There 

are no additional safety precautions beyond the PPE that is listed that is required. 

 

8. Please simplify the Protocol so that individual steps contain only 2-3 actions per step and 

a maximum of 4 sentences per step. 

We limited our sentences in our protocol to a maximum of 4 sentences per step. 

 

9. The Protocol should contain only action items that direct the reader to do something. 

Please move the discussion (for e.g., in steps 4 and 5) about the protocol to the Discussion. 

All non-actionable language was removed between the sections of the protocol.  

 

10. Please use a single line spacing between steps and substeps of the protocol. Please limit 

the highlighting to up to 3 pages of the Protocol (including headings and spacing) that 

identifies the essential steps of the protocol for the video, i.e., the steps that should be 

visualized to tell the most cohesive story of the Protocol. Remember that non-highlighted 

Protocol steps will remain in the manuscript, and therefore will still be available to the 

reader. 

Single line spacing was used between all steps and substeps of the protocol, and the 

highlighted text is limited to 3 pages. 



 

11. Figure 1 and 2: Please include scale bars in all the figure panels. 

Scale Bars have been included in all figure panels. 

 

12. As we are a methods journal, please ensure that the Discussion explicitly also covers the 

following in detail in 3-6 paragraphs with citations: 

a) Critical steps within the protocol 

b) Any modifications and troubleshooting of the technique 

c) The significance with respect to existing methods 

d) Any future applications of the technique 

The discussion has been modified to include points a – d. 

 

13. Please expand the journal names in references. 

We corrected the reference style and now journal names are expanded in the references. 

 

14. Please ensure that all materials/reagents/equipment/software used in the study are 

listed in Table of Materials along with the associated catalogue and vendor information. 

We have verified that the Table of Materials is accurate and includes catalogue and vendor 

information. 

 

 

____________________________________ 

Reviewers' comments: 

We thank the reviewers for their helpful comments, which have greatly improved our 

intravital segmentation protocol. Our point-by-point response to individual comments can 

be found below. 

 

Reviewer #1: 

Manuscript Summary: 

The goal of the manuscript is to provide methodology for intravital imaging of the tumor 

microenvironment, more specifically the interactions between cells and the extracellular 

matrix (ECM). The authors have described how to achieve these observations without 

exogenously administered dyes by exploiting collagen second harmonic signal, endogenous 

fluorescence of NAD(P)H and fluorescence lifetime imaging microscopy (FLIM). As a model 



system, MMTV-PyMT mice were utilized, which spontaneously generate mammary tumors 

and go through similar stages to human breast cancer progression from benign to 

malignant primary lesions to metastases. The manuscript is very interesting and will be 

valuable for other imaging researchers. The following major and minor points are 

recommended to improve the manuscript: 

 

Major Concerns: 

* In the discussion of 3D in vitro culture systems in the Introduction, it would also be 

important to briefly discuss the role of microfluidic tumor models for visualizing cell-matrix 

interactions and cite a few papers. 

While we recognize the importance of microfluidic models to the field, we feel that this is 

outside of the focus of this protocol. However, to provide our readers with a broad 

perspective, we have included a brief discussion of microfluidic tumor models and their 

citations into the first paragraph of the introduction (lines 60-64).  

 

* Limitations of surgical damage in implantation of the window and the inability to capture 

the whole tumor depth should be noted (specifically how much depth penetration one can 

achieve with each imaging technique proposed). 

We agree with the reviewer, Mammary Imaging Windows (MIW) are not always the best 

choice for every intravital application. Our surgical methods are based on prior work 

developed by our collaborators, which aim to minimize tissue damage during surgical 

implantation of the window ( DOI: 10.1038/nmeth.1269). Here, we specified the use of MIWs 

based on their utility for longitudinal studies and pointed out that terminal skin flap models 

might be better when more access is needed (lines 459-468). In addition, we reworked 

figure 1 to include a montage of the tumor taken at different depths. 

 

* The authors could mention that a limitation of conventionally used dyes such as luciferase 

and green/red fluorescent protein (GFP/RFP) is that they are foreign to the mouse. GFP/RFP 

and/or luciferase tagged tumor cells that are injected into an immunocompetent mouse will 

experience a decrease in metastasis compared to these cells injected into 

immunocompromised mice due to the body's immune reaction against the foreign proteins. 

You could cite these papers: 

o Baklaushev, V. P., Kilpelainen, A., Petkov, S., Abakumov, M. A., Grinenko, N. F., Yusubalieva, 

G. M., Latanova, A. A., Gubskiy, I. L., Zabozlaev, F. G., Starodubova, E. S., Abakumova, T. O., 

Isaguliants, M. G. & Chekhonin, V. P. Luciferase Expression Allows Bioluminescence Imaging 

But Imposes Limitations on the Orthotopic Mouse (4T1) Model of Breast Cancer. Scientific 

reports 7, 7715, doi:10.1038/s41598-017-07851-z (2017). 

https://doi.org/10.1038/nmeth.4511
https://doi.org/10.1038/nmeth.4511


o Baklaushev, V. P., Grinenko, N. F., Yusubalieva, G. M., Abakumov, M. A., Gubskii, I. L., 

Cherepanov, S. A., Kashparov, I. A., Burenkov, M. S., Rabinovich, E. Z., Ivanova, N. V., 

Antonova, O. M. & Chekhonin, V. P. Modeling and integral X-ray, optical, and MRI 

visualization of multiorgan metastases of orthotopic 4T1 breast carcinoma in BALB/c mice. 

Bulletin of experimental biology and medicine 158, 581-588, doi:10.1007/s10517-015-2810-

3 (2015). 

We agree with the reviewer that this is a limitation of the field. We have now included a new 

paragraph in the introduction that highlights this point (Lines 94-102), and further 

demonstrates the need for new segmentation approaches for intravital imaging.  

 

* Is the purpose of this protocol to have other investigators use their own imaging windows 

for the same procedure or introduce other people in the field on how to perform these 

techniques? It may be useful to provide a CAD drawing for the mammary ring window or 

provide a citation for another available drawing so researchers can be pointed to another 

resource. 

To clarify, the purpose of this protocol is two-fold. First, it is meant to show investigators 

how to install MIW for longitudinal intravital imaging. We have included references and a 

CAD drawing of the MIW and a cartoon schematic of surgical implantation in Figure 1. The 

second important purpose of this protocol is the use multi-dimensional endogenous 

fluorescence that is ubiquitous to enhance the quantification potential of intravital data. The 

protocol outlines how to collect ancillary images of endogenous fluorescence for the 

purpose of segmenting the tumor landscape. The benefits of this approach include its 

flexibility and versatility. It is not dependent on a particular window and in fact we reference 

other window options in the introduction (line 72-75).  

* If bleeding occurs during surgical implantation of the MIW, what is the course of action? 

How does one avoid bleeding? Are there any special steps to be taken? 

Bleeding can occur during this protocol and we supplied a note on how to address it in 

section 2.6 (Lines 181-184). 

 

* Several items should be added to the material/equipment sheet at the end of the 

document - forceps, surgical micro-scissors, heating blanket/heating chamber (if what you 

use is a custom part - please provide other options that can be used instead of this like 

heating pads, etc), objective heater, custom fitted stage insert (any information that could 

be provided for this?), Hamamatsu H7422P-40 GaAsP detector, a Becker and Hickl SPC-150 

photon counting board. 



The table of materials has been updated to give a comprehensive list of the supplies and 

equipment needed to complete this approach. 

 

* In step 4 "Setup for 4D,…" please be sure to note the configuration of the microscope if it 

is upright or inverted. Also, details on the objective magnification, NA, and immersion 

medium is crucial. If it is water immersion, adding water to the mammary window will be 

important to add. A baseline level of laser power should be specified to start from which 

would be helpful to avoid tissue damage/photobleaching. It would be helpful to explain 

what saturation of the detectors means - how can you tell if saturation is achieved? The 

signs of phototoxicity and photobleaching should be explained. 

A note/tip for the use of immersion media was added and a few symptoms of 

photobleaching and phototoxicity were described. We choose not to elaborate on the PMT 

saturation because basic microscopy knowledge is a requirement for such an advanced 

microscopy technique. Therefore, we felt that explanation would be unnecessary and 

redundant for our readers. Instead, the goal of determining optimal settings has been 

clarified in the text.  

 

* In Step 5 "FLIM of NAD(P)H…", the setup of the urea crystals should be explained in a little 

more detail - how are the crystals prepared? Are they dry or in a solution? Which solution? 

Do they have to be imaged underneath a glass coverslip? 

The urea crystals are not prepared; they are commercially available and purchased from a 

company. The company name and product number were listed in the table of materials. 

Additional text was added (lines 305-308) to further clarify how the crystals were imaged to 

collect an instrument response function. 

 

* In Step 7.5 "Image segmentation of the vasculature…" what is the desired result of the 

thresholded images you are trying to achieve? This could be helpful to write a sentence or 

two about desired results. In Step 7.8 in the same section, how much dilation is needed? An 

explanation of the goal of this step would be helpful to better define what is to be achieved. 

We thank the reviewer for pointing out the need for clarification in this section. The intent of 

vasculature segmentation and dilation of the subsequent vascular mask was to demonstrate 

the possibility of analyzing cells localized at varying distances away from vasculature. The 

amount of vascular dilation is a parameter that is set by the experimentalist and dependent 

on the goals of the individual study.  An additional note was added to highlight the goal of 

the dilation (line 369-372).  



 

* In Step 8.3 "Image segmentation of the tumor nest…" What indicates a suitable classifier? 

This should be specified. 

Additional text has been added to better explain the end goal of the segmentation 

procedure and what is a suitable classifier. 

 

Minor Concerns: 

* Representative Results: yellow arrows are mentioned on Fig 1C but there are no yellow 

arrows in the figure. Please add the arrows. 

We apologize for this omission; we have corrected the figure to include yellow arrows.  

 

* Figure 1 caption: it mentions gold stars and red triangles but these shapes are not shown 

in the figure. Please add them to the figure. The gold stars and red triangles have been 

removed and eliminated from the captions. 

 

* In Figure 2, the contrast between the red color and magenta colors is not easily 

discriminated. Picking a different color for either red or magenta in the figure would be 

helpful. 

We agree with the reviewer, the colors and layout of the figure made it difficult to follow. 

We increased the contrast of the red channel to make the vasculature more obvious. We 

also added arrowheads to train the readers eye to the magenta-colored macrophages. In 

addition, the layout of the figure has been modified to better convey the process and 

possibilities of image segmentation based on endogenous, label-free fluorescence. 

 

 

Reviewer #2: 

Manuscript Summary: 

In this useful protocol, Ponik et al. present a full-pipeline to recover stroma structural 

information from auto-fluorescence (classic, second harmonic generation, FLIM) in intravital 

microscopy. The authors use this technique to incorporate the stroma dimension to 

intravital study notably to analyse the stroma resident cells and the overall mechanical 

backbone of the tissue through isotropic collagen fibres. 

This technique is valuable for the field and deserve to be shared. Indeed, intravital 

microscopy is often half-blind technique and any new imaging dimension allowing 

structural or positional reference as like any extra information layer is needed. Moreover, 

FLIM technology is not widely used due to required specialist equipment: inexperienced 



users will likely find this work useful and may justify integration of such modules on 

intravital setups. 

However, the manuscript need refinement to be more general and reach a broader 

audience. Indeed, the technique is not only useful for PyMT stroma study, which is the felt 

by reading the manuscript and should be opened for use in other conditions (eg. tissue 

physiology). A review of the animal parts by a vet is strongly recommended. As very 

practical journal, many "custom" elements must be shared or obtainable. Only based on the 

manuscript, it is sometime very difficult to visualize. 

This protocol will be useful for many once following points will be addressed. 

 

Major Concerns: 

- Some important missing information about animal ethics are missing (><) and should be 

added/modified for worldwide audience (where the ethic become stricter and stricter). A 

review of this part by the authors' responsible vet could be a good idea before making a 

movie. 

Additional language was added to address the ethical care of the animal and a veterinarian 

has reviewed the manuscript to verify compliance with our UW-IACUC approved animal 

protocol (lines 141-144). We also commented on the use of the analgesia/anesthesia and 

the incision/implantation procedure (lines 170-172).  

 

* 2.0: it may be obvious for authors but an extra bullet point precising that the tools were 

autoclaving etc… could be a plus. 

We agree with the reviewer that a reminder to autoclave materials may be helpful for 

readers. An extra bullet point was added for autoclaving (lines161-162). 

 

* 2.1: add warming blanket temperature and reference. Precise that auxiliary lighting should 

be "cold-light" to avoid tissue drying and add a reference. Precise that surgical sleeves, 

gloves, lab coat should be sterile, single use and equipped as recommended by the surgical 

best practices. 

The requested text was added (lines 163-169). 

 

* 2.2: >Isoflurane allows anaesthesia but not analgesia (!), authors should mention the use of 

proper analgesic prior incision and not only after surgery.< Application of betadine should 

be the last step prior surgery since it is a much better and more persistent disinfectant than 

70% ethanol. If any reason, authors should explain why this ethanol step is added (to avoid 

betadine to stain the tissue?). 



We added text for the administration of an analgesic prior to any incision (170-172). An 

optional note was added to describe why we wipe with ethanol after betadine solution. We 

do this step because betadine does tend to stain the tissue, but this step also helps prevent 

any flakes of skin or debris from entering the wound site. We also explicitly discussed this 

point with our veterinarian staff and changed the text to recommend multiple scrubs (177-

178). 

 

* 2.3: On top of a future video showing this, a schematic draw of the incision localisation 

would be a plus for the reader. >Such technique (making a hole by sectioning pulled skin) is 

classic for dissection but not recommended for surgery where straight incision is preferred.< 

The reviewer is correct that under most scenarios a straight incision is preferred. However, 

the mammary imaging window is a rigid device with a diameter of 10 mm. We have found 

we get much better implantation longevity and results if we remove some of the epithelium. 

A new figure (Figure 1) has been added to better describe the process. 

 

* 2.6: Authors should mention which antibiotic (molecules, dosage, administration way). 

We topically apply the triple antibiotic ointment listed in the materials to the surgery site. 

We modified the text for clarity (line 198). 

 

-3.6: Respiration frequency follow up is a valuable tip but how authors measure the 

respiration per minute (rpm)? Authors mention to adjust the isoflurane during the imaging 

session: authors should add reference values (eg. Isoflurane between 0.5-2%), notably the 

flow rate should be ranged between 0.5-1L/min contrarily to induction where it can be 

higher (3.2: 2L/min) 

The respirations per min are measured by manually counting breaths over a 30 s time 

period. Additional text was added to clarify this point (line 230). 

 

- 3.5 Authors must provide blueprints, reference or at least schematics of every "custom" 

part to allow reader to better understand and/or replicate the protocol. Moreover, authors 

did not mention the microscope setup (inverted, upright?) nor the objectives (magnification, 

reference). 

We added text to better describe the inverted microscope setup and objectives used in this 

protocol. It should be noted that this technique can be done on either an upright or 

inverted system. We have successfully used both but the inverted set up minimizes 

breathing artifacts (Line 447-449). We have also noted that other objectives can be used so 

long as they have an extended or long working distance. 



 

-7-9: Authors must share a demo dataset and a demo classifier to allow user to better 

understand, reproduce and train themselves to reach the expected results. This is very 

important since authors say “For good results, high quality images with discernible fibres 

and low noise are required”. 

An image and classifier model will be uploaded upon resubmission. 

 

-Authors mention that they develop this label-free pipeline “because it gives the broadest 

potential compatibility with other mouse models”. Authors must show or reference this 

compatibility. In other words, is strong CFP/GFP/YFP signal from mouse reporter not 

altering such analysis by aspecific signal passage through blue filter, since their excitation 

wavelengths are similar? 

This is a CRUCIAL point that could be easily addressed by applying the pipeline on any GFP 

expressing mouse. 

This is an excellent point. To address this, we conducted additional experiments with 

allografts of GFP-labelled cancer cells. We did not have a GFP-mouse up and running within 

our colony at the time of submission. Regardless, the GFP did not interfere with the ability 

of the FLIM images to identify the vasculature. It seemed remarkably robust to interference 

from GFP fluorescence. 

 

Minor Concerns: 

-Title: Intravital imaging of endogenous fluorescence enables investigation into the dynamic 

reciprocity between tumour cells and the extracellular matrix. The title should be changed to 

reflect more closely what the protocol does, as opposed to what it could do 

The title has been altered to more closely describe what the protocol does. 

 

-Over the use described by authors, such technique may be crucial for any intravital study. It 

provides multiple localisation cues on a new dimension (FLIM) that is really important for 

any behaviour study within the stroma or not. The authors should stress the polyvalent use 

of their technique in intravital microscopy because indeed, dextran block a channel, is 

transient, invasive and not very convenient (an extra step to an already difficult and low-

throughput technique). Moreover, from an ethical point of view, any technique that allows 

to reduce mouse manipulation (such injection of dextran) is valuable. 

This is an excellent point and we devoted extra text in the introduction toward the problems 

with fluorescent proteins or injectable dextran and the utility of endogenous fluorescence 

for intravital image analysis (lines 87-104). 

 



-Page 4 (line 89). While tumour cells are typically considered metabolically more active, and 

therefore there is an expectation that NAD(P)H to fluoresce at a higher intensity, this will 

likely vary from tumour to tumour (and indeed between different regions within the same 

tumour). Including an example of the NAD(P)H signal intensity in the normal mammary 

epithelium would be helpful as a negative control, as well as a discussion (and relevant 

citation(s) as necessary) to the range that might be expected. 

Can this approach be used to identify early, pre-malignant tumour cells/lesions? 

 

Once again, this is an excellent point and indeed the use of NAD(P)H FLIM has been 

demonstrated to vary within tumors and be useful to distinguish normal vs malignant 

lesions in prior work published by members of our group (Cell Biochem 

Biophys. 2009;53(3):145-57. doi: 10.1007/s12013-009-9046-7).  

For this manuscript, we want to keep it focused on using autoflourescent sources to 

compartmentalize intravital images. The purpose here is to simply provide a means to gate 

or threshold an image to compartmentalize the different microenvironments of the tumor. 

We have used genetic tumor models and numerous cell lines for xenografts. In all our 

experience, NADH, while sometimes variable, always provided a means to demarcate the 

boundaries of the tumor. We, therefore, want to restrict our talking points about that rather 

than expand upon its utility as a metabolic tool. 

 

-1.3: Ethanol cleaning, especially for only 1 minute, would be better called "quick 

disinfection" than "sterilization" (autoclaving, dry hoven, ethylene oxide, …). This should be 

rephrased. In this purpose, why authors use 100% ethanol instead of 70% ethanol that is 

known to display higher disinfection property? 

We change the text to read that it is a quick disinfection rather than sterilization. We also 

changed it to read 70% ethanol. 

 

-2.4: Authors should help reader by estimating the incision length to make Ø10mm hole 

(2r*pi / 2?) The incision length should be 10 mm. We modified the text to clarify that. 

 

 

-3.1: This tip about thermal expansion is a very valuable advice. 

We would like to thank this reviewer for their kind words. This tip is indeed helpful, 

especially when an immersion media is used. It is less important if you are using an air 

objective. 

 



-3.2 Add "isoflurane" after 2%. "…with anesthesia machine settings of 2% isoflurane and…" 

The text has been modified (line 212). 

 

-3.3 Authors should precise the solution used for MIW cleaning (ethanol? water?) 

We use sparkle glass cleaner on a cotton applicator. It only touches the glass and the metal 

collar protects the surrounding skin. The text has been modified for clarity on this point and 

it has been added to the table of materials. 

 

-4.3. Representative pictures of the different layers (solitary cells, collagen fibres, poor 

signal) would be helpful for the reader and during imaging. 

We have added a new figure to show how the tumor and collagen change with depth 

(Figure 1).  

 

-4.4: What is the point to adjust laser intensity/PMT in 4.3 at dwell time of 4µs to readjust it 

just after with 8µs? In 4.3, could not be better to preview in "gross mode" with low laser and 

high PMT (very noisy but low exposure) and just spend time to setup high quality imaging 

in 4.4 with optimal laser intensity/PMT?  

We appreciate this comment as it helps with the clarity of our text. In 4.3, the use of low 

laser intensity and dwell time is to preview the field of view and setup for the high-quality 

image in 4.4.   We added a note to clarify this point. (line 250-251) 

 

-4.5: About the time interval, a mention about the z-step interval and the picture dimensions 

(pixels x pixels) would also be useful. 

Considering microscopy advice, especially for scanning confocal beginners, a short tip-box 

about how to estimate the smallest time interval per field (z-steps * x_resolution * 

w_resolution * dwell_time * averaging) would be great. Indeed, for multiple large 3D stacks, 

10 minutes can be quickly unreachable (with the authors settings, a 1024*1024*60 3D stack 

would already take more than 8 minutes to acquire, banning a second position) 

 

The time interval depends entirely on the goals of the experiment. Longer dwell times 

produce better images, but anything above 8 µs seems to put you at high risk for photo 

damage. This, of course, is dependent on specific power settings and absorption or 

scattering of the specific tissue. We view this as a generally safe maximum value. While I 

agree that the tip box would be useful for beginning users, this technique requires prior 

microscopy training, and that information will likely not be helpful to most readers. In fact, 

intravital imaging is a very advanced technique that should not be attempted without some 



prior expertise in two-photon or confocal microscopy, which would include expertise in 

imaging parameter optimization. 

 

-7-9: These parts could only be review upon demo dataset sharing but is theoretically 

correct. 

If authors now how to do it, a ready-to-use ImageJ macro for these processing pipelines 

would be very useful and easily scalable to single-z, z-stack or max projections. 

While having a macro would be useful, we have found macros require extensive 

optimization and may depend on the user-defined microscopy parameters. Therefore, we 

currently do not have refined macros that are suitable for broad dissemination. Rather, we 

have a streamlined workflow which we presented. As this technique is used more in the lab, 

a script will be written and we will share via the lab website. 

 

- Figures could be better represented and annotated. 

* Figure legends refer to arrows, gold stars, red triangles which are not represented on the 

PDF.  

The figures have been revised to improve representation of the protocol.  The gold stars 

and red triangles were missing; An older version of the figure was uploaded accidently, 

which has now been corrected. 

 

* Authors should add on Figure 1 the signal origin to stress that is is label-free imaging (eg. 

Collagen (SHG)).  

Figures 1 and 2 have been revised and labeled to stress the signal origin. We have also 

stressed this point in the figure legends and text. 

 

* Authors should add merged image of E and F to better see (miss)matches of label-free 

FLIM imaging and classical dextran imaging. 

An additional panel with a merged image was added to the figure.  

 

* Authors should reconsider the Table 1 representation to a classic histogram plot showing 

FOV as individual dot (Y: Area ratio, X: mice). 

The data shown in the table has now been formatted into a dot plot and included into the 

updated Figure 2. 

 



-Authors must add short result-dedicated methods embedded in the text to explain at least, 

when the dextran was injected (hopefully, after label-free images acquisition to exclude 

cross-signals), its molecular weight and its fluorophore as like the microscope setup. 

Additional text was added to the manuscript to better describe the approach for our 

comparison. The fluorescent dextran was also added to the material sheet. 

 

-Image restoration through machine-learning is a trendy topic, being progressively 

implemented within microscope softwares. 

* Considering 1E and 1F, it is fairly imaginable to retrieve dextran imaging quality through 

FLIM layer (see CSBDeep) - training pairs FLIM/Scanning 

* This can also drastically reduce FLIM acquisition time - training pairs shortFLIM/longFLIM 

* And maybe both - training pairs shortFLIM/Scanning 

Since these aspects are currently presented as limiting points of authors technique, it is also 

important to mention and discuss that these may be easily overcome through fast post-

processing. 

We strongly agree with the reviewer on this point and have given it extensive thought. A 

few lines of additional text have been added to the discussion to address this point (lines 

671-679).  



training dataset Click here to access/download;Supplemental File (Figures,
Permissions, etc.);MAX_NADHlifetime_750nm_ms311_FOV1.tif

https://www.editorialmanager.com/jove/download.aspx?id=1422970&guid=20787c43-7385-4ede-9d87-f5f3feee6907&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1422970&guid=20787c43-7385-4ede-9d87-f5f3feee6907&scheme=1
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Supplemental Coding Files
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https://www.editorialmanager.com/jove/download.aspx?id=1422971&guid=d80797c3-9ac5-419c-81aa-43d748f902ca&scheme=1

